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About the speaker

« Courtney Watts is a Data Scientist with a Master’s in Statistics and Data
Analytics. Courtney is a leader in Advanced Analytics, bringing over 13 years
of comprehensive experience across all aspects of Machine Learning,
Analytical Solutions & Reporting, and software training. With a robust skill
set that includes Power Bl, Machine Learning, R Programming, SQL
Programming, Technical Training, and D365 Embedded Analytics, Courtney
offers a unique blend of technical expertise and practical insights.

« Courtney also emphasizes and understands the critical importance of
establishing data governance within analytics and software development,
ensuring a solid foundation before leveraging Advanced Analytics or
Reporting solutions
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| Agenda

1.The Power Platform
2.0verview of Power BI
>.Data Example (Excel)
4..Data Connectivity
5.Data Transformation
6.Visualizations
/.Interactive Dashboards

3. Collaboration and Sharing
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The Power Platform v

« The Power Platform is a Saa$ services that enables
users to Analyze, Act, and Automate their data and

Power BI Power Apps Power Automate Power Virtua Iﬁgenix
i alytics ~ Application development
| | | |
o © S ®
ata Portals Al Builde Dataverse
connectors
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Power Bl

Power Bl is user-friendly and
designed to be accessible for a
wide range of users across
various teams. Its intuitive
interface allows individuals
with varying levels of expertise
to effectively harness its
capabilities for data analysis
and visualization

{3 COMMUNITY
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Power Bl

Power Bl Desktop is free

Easily Integrated with Excel, Power Point,
and SSMS

You can create custom visualization or
themes for data analysis and visualization
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Key Features

Data Connectivity:

Power Bl can connect to a wide range of data sources,
including Excel, SQL Server, cloud services (like Azure,
Google Analytics), and many others.

Data Transformation:

Using Power Query, users can clean, transform, and
shape their data before creating reports. This includes
filtering rows, adding columns, merging tables, and oneNote

more. [ﬂ

Visualizations:

Power Bl offers a variety of visualizations such as bar
charts, line charts, pie charts, maps, and custom visuals.
Users can easily drag and drop to create engaging
dashboards.

Interactive Dashboards:

Dashboards can be created with multiple visualizations
that interact with each other, allowing users to drill Bisees
down into specific data points for deeper insights.

will interpret and generate the appropriate visuals.
Collaboration and Sharing:

Reports and dashboards can be shared with others in
the organization via the Power Bl service. You can set
up row-level security to ensure that users only see data
relevant to them.

Mobile Access:

Power Bl has mobile apps that allow users to access
reports and dashboards on the go, ensuring they can
stay informed anytime, anywhere.

Integration with Other Microsoft Products:

Seamlessly integrates with other Microsoft tools like
Excel, SharePoint, Teams, and more, enhancing
productivity.

Microsoft | Skateboard Store

Net Sales

52,646
$a724
$1,568
$2,842
$3626
$1,764
$1274

$2.744
$1372
$2,040
52,646
52,548
$1,078
$30,772
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Last R n 30th, 2 0, IL, US: Visualizations Fields
B E =M
Net Sales (Forecast) Extra Profit

$30,772 $0

“What If” Analysis Forecast
®predicted Net Sales ®Forecast

Drill through
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Power Bl Layout ;2 COMMUNITY

1.The Home tab is where the most common operations wolmm e e o=l A

you perform are available. sanpcs ZlgeEmasE

2. The Insert tab in the ribbon allows you to insert . _hl:h = 1 Fld

shapes, a text box or new visuals 2 AT E00E v
oEmash e

3.The Modeling tab in the ribbon enables additional data R Vv

modelling capabilities like adding custom columns and
calculating measures.

Drill through

4. The View tab has options to format the page layout.
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Power Bl Layout Cont'd ;2 COMMUNITY

1. The Help tab provides self-help options like guided learning, S | SR OED EE &
training videos, and links to online communities. I IR e e—

M l. ¢ Visualizations > Fields
2. On the left side of the window, you have three icons, Report, <BHEWEN oo
Data, and Model. If you hover over the icons, you can see the HELOOE S
tooltips. Switching between these allows you to see the data and aEEd . i
the relationships between the tables. — o

7

3. The center white space is the canvas where you will be creating
visuals

Drill through
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Sample Data {2 COMMUNITY

File' Home |Insert Draw Pagelayout Formulas Data Review View Automate Help

° o J— .
Flle Type: Exce' X |Aptos Narrow "H11 V| A A = = |§| ?E; |Genera| V| [E] conditional Formatting v
Columns: B =S=Z=E- $+% 9 BifomatasTable-
<5? - == G 0 [iZ Cell Styles v
Clipboard [ Font = Alignment = Number 5 Styles

1. Customer Name

K7 v i i
2. Company Size A - . . ‘ ' ¢ ’ J
3 . C u Sto m e r G ro u p Customer Corr!pany Customer Payment Cre_dit State Parent Sales Rep Revenue

1 Name Size Group Terms Rating Company
4. Payment Terms Alics

] . 5 John Doe Small Bronze 30B New York ABC Corp Johnson 10,000.00 |
5 . Cred It Ratl n g 3 Jane Smith Medium Silver 60 A California XYZ Inc. Baob Smith 5,000.00 /
S 4 Emily Johnson Large Gold 90 A+ Texas 123 Industries Carol Lee 8,000.00 :
6 . ta te 5 Michael Brown Small Bronze 30C Florida Acme Corp David Brown 5,000.00 /
. . . L Global Emma ",;".»’

7 . Pa re nt CO m pa n y 6 Sarah Davis Medium Silver 60 B+ Illinois Solutions White 7,000.00 ,'?""-"',v
8. Sales Re 8) _ DavidWilson  Large Gold 90 A z\';aSh'"gT r:::vations Frank Green 2,000.00 y
9 ] Reve n u e 9 Jane Doe Medium Silver 60 A Texas TZY Corp i)li::son 2,000.00 /, '

9 Michael Davis Small Bronze 30 A Texas ABF Corp Bob Smith 3,000.00 .;_.’:..‘/-'
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Obtaining Data
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. . . . Get Data
Data types are organized in the following categories:
* A” I ] All
3 File | © ||a Excel Workbook A
- Database A
. . . [F Text/Csv
. Microsoft Fabric File
5 XML
. Power Platform Database
: . (] JSON
i Azure Microsoft Fabric
. Online Services bower Platform Folder
) Other Azure & ror
. . Parquet
) . . Online Services
The All category includes all data connection types from all categories. Other B SharePoint folder
SQL Server database
«  The File category provides the following data connections: K Access database
* Excel SQL Server Analysis Services database
. TeXt/CSV Oracle database
. XML
IBM Db2 database
. JSON
IBM Informix database (Beta)
. Folder
. IBM Net
+  SharePoint Folder e o
MySQL database
Certified Connectors Template Apps Cancel
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Data Connectivity: 12 SOMMUNITY

File Home Help Table tools
@ 1= g o= T
H% {@) ~ eas HEEI T
EB COpy E:IE [E E% [% _/ [5_} =] T 1 Q R
Get Excel Onelake SQL Enter Dataverse Recent Transform Refresh Manage New  Quick New New Manage View
datav workbook data hubv Server data sources v datav relationships ~ measure measure column table roles as
Clipboard Queries Relationships Calculations Security Sens

Common data sources

* Select the Home
Date |*|1 I}?! Excel workbook .
01/01/2013 d% , RI b bo n

=
=
=

Power Bl semantic models
01/02/2013
01/03/2013 [ Datatiows ° S e | eCt G et Data
01/04/2013 (@) Dataverse

01/05/2013
01/06/2013 [‘é SQL Server

01/07/2013 [% Analysis Services
01/08/2013
01/09/2013 I:hEl Text/CSV

01/10/2013 Web
01/11/2013 I:é

01/12/2013 I__é OData feed

T

01/13/2013

13/ I_—E: Blank query
01/14/2013
01/15/2013 EE Power Bl Template Apps @
01/16/2013

01/17/2013 More...

01/18/2013 s o
01/19/2013 7 Jan 2013
01/20/2013 7 Jan 2013
01/21/2013 7 Jan 2013

ble: Date (3,287 rows)
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Data Connectivity: 12 SOMMUNITY

L v /N [l > Desktop ~ O Search Desktop P
Organize ~ New folder = - [ o I:I_l-l{_ . [I%
N ~ at dified New Text More
 Home ame ate moditie visual box visualsv [ ) S e | ect th e
b . Insert Calculations Sensitivit
E] Gallery Summit 9/26/2024 12:37 PM —

sample excel
file created

> @ Courtney - Colui

Deskt »
o « Select Open
- Downloads #
— Documents #
ita pane.
PN Pictures »
P . ______________________________________________________| @_
File name: ~ | Excel Files (* xI:* xlsx;* xlsm;* xlsk ~
e Use sample data

Open v Cancel
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Data Connectivity: 52 COMMUNITY

P | Sheet3 2
Display Options ~ E& Customer Name Company Size Customer Group P Y | t h N 5 t
4 Summitxlsx [1] John Doe Small Bronze n e a VI g a O r
Jane Smith Medium Silver
D Sheets Emily Johnson Large Gold S C ree n S e | eCt
Michael Brown Small Bronze
Sarah Davis Medium Silver | Oa d
David Wilson Large Gold -
Jane Doe Medium Silver ) Y d t t
Michael Davis Small Bronze O u r a a S e I S
now within
Power Bl
< >

|Transform Datal | Cancel |
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Data Connectivity: 12 SOMMUNITY

* In the Navigator Screen select load
* Your dataset is now within Power B

g H

~ Data P
Customer Name | ¥ | Company Size | ¥ Customer Group | *| Payment Terms | Credit Rating |¥| State |¥| Parent Company || Sales Rep |¥| Revenue |~
John Doe Small Bronze 30 B New York  ABC Corp Alice Johnson 10000 Q search
Jane Smith Medium Silver 60 A California ~ XYZ Inc. Bob Smith 5000 | > [ Sheet3
Emily Johnson Large Gold 90 A+ Texas 123 Industries Carol Lee 8000
Michael Brown Small Bronze 30 C Florida Acme Corp David Brown 5000
Sarah Davis Medium Silver 60 B+ Illinois Global Solutions Emma White 7000
David Wilson Large Gold 90 A Washington Tech Innovations Frank Green 2000
Jane Doe Medium Silver 60 A Texas TZY Corp Alice Johnson 2000
Michael Davis Small Bronze 30 A Texas ABF Corp Bob Smith 3000
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Data Transformation
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Data Transformation:

Data > File Home  Help  Table tools
i ?‘ o= = p p
HH T
Q_ Search 1 Cony E% [E @ I:%j ﬁ @) I:Iég =7 I:?j |- Q ~Q
Get Excel Onelake SQL Enter Dataverse Recent Transform Refresh New  Quick New New Manage View
l >Esh datav workbook data hub~ Server data sources v data~ measure measure column  table roles as
New measure

Clipboard Data lips Calculations Security Ser

?j Transform data

I:E;} Data source settings

New column

=
=
=

New quick measure Customer Name | ¥ Company Size || Customer Group |~ | Payment Term: ¥ | Parent Company |~ | Sales Rep | ¥ | Revenue |~

Refresh data B John Doe Small Bronze York  ABC Corp Alice Johnson 10000
I Edit query ﬂg Jane Smith Medium Silver yrnia XYZ Inc. Bob Smith 5000
Emily Johnson Large Gold ; 123 Industries Carol Lee 8000
Incremental refresh mj Michael Brown Small Bronze 30 C Florida Acme Corp David Brown 5000
Manage aggregations " Sarah Davis Medium Silver 60 B+ Illinois Global Solutions Emma White 7000
David Wilson Large Gold 90 A Washington Tech Innovations Frank Green 2000

Copy table
Jane Doe Medium Silver 60 A Texas TZY Corp Alice Johnson 2000
Rename Michael Davis Small Bronze 30 A Texas ABF Corp Bob Smith 3000

Delete from model

Hide in report view

. Steps to access the Power Query Editor

Expand all
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Data Transformation:

Power Query Editor o ] X
ansform Add Column View Tools Help ‘
: = - Cl Dat
D D D 55 Properties |:| LI 2% 4l % Data Type: Whole Number ~ P — Text Analytics ea n a a
~ +
=~ D}Advanced Editor x El F —| [ Use First Row as Headers ~ @ Vision o
it Enter Data source Manage Refresh Choose  Remove  Reduce Split  Group 4 Comblne ) U d t F t R
s~ Data settings Parameters~  Preview ~ FH NEEEE Columns ~ Columns~  Rows~ Column~ By 22 opirhes é s p a e I rS OW
lery Data Sources  Parameters Query Manage Columns Sort Transform Al Insights aS Headers
< ﬁc = Table.TransformColumnTypes(#"Promoted Headers",{{"Customer Name", type text}, v Query Settings X
= ] customerGrovp |~ | [ | e Credit Rating < state 4 PROPERTIES e Format text
1 Bronze 30 B New York LTI
Sheet3

2 Silver 60 A California sheet2

3 Gold 90 A+ Texas All Properties

- Bronze 30 C Florida

4 APPLIED STEPS

5 Silver 60 B+ lllinois

6 Gold 90 A Washington ST

7 Silver 60 A Texas Navigation

Promoted Headers
8 Bronze 30 A Texas

> Changed Type
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Data Transformation:

Home Transform Add Column View Tools Help ¢ Ad d I n g C u Sto m

L]
-1 Conditional Column Merge Columns Trigonometry ~ — CO | u m n S I S
fx Index Column ~ 135 Extract ~ ': Rounding ~ .
Column From gustom Invoke Custom i I Format Statistics Standard Scientific g ) Date  Time Duration Text S I m p | e
Examples~  folumn ENe Duplicate Column - Parse - - - Information - - - Analytic
General From Text From Number From Date & Time ° b . | °
Abllity to
Tl Add Column From Examples (7]

Enter sample values to create a new column (Ctrl+Enter to apply). C re a te C u Sto m

columns or f

_ columns from
1 John Doe Small Bronze exa m p | eS

2 Jane Smith Medium Silver :
3 Emily Johnson Large Gold

4 Michael Brown Small Bronze

5  Sarah Davis Medium Silver

6  David Wilson Large Gold

7 Jane Doe Medium Silver

8 | Michael Davis Small Bronze
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Data Transformation:
ome

olumn From Custom Invoke Custom

Examples ~

Column

Transform

fx

Function

General

Trigonometry ™

': Rounding ~

Add Column View Tools Help
- Conditional Column Merge Columns
Index Column ~ 155 Extract =
) Format Statistics Standard Scientific
Duplicate Column - Parse ~ - - -
From Text From Number

e

[o=T e VI = T R B - WS B L6}

Add Column From Examples

Enter sample values to create a new column (Ctrl+Enter to apply).

Transform: Text.BeforeDelimiter([Customer Name], " ")

Information ~

Date Time Duration

- -

From Date & Time

‘8 COMMUNITY
2} SUMMIT

= * Adding Column
from example

¢ Adding Customer

o first name

John Doe Small
Jane Smith Medium
Emily Johnson Large
Michael Brown Small
Sarah Davis Medium
David Wilson Large
Jane Doe Medium
Michael Davis Small

Bronze
Silver
Gold
Bronze
Silver
Gold
Silver

Bronze

John
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Data Transformation
+ Select Close and Apply

Home Transform

Add Column View Tools Help

i EE Properties LI % '%l Data Type: Text ~
=P "D ﬂ . x z |_ —| .
EE-Advanced Editor Al D Use First Row as
Close & Recent Enter Data source Manage Refresh == Choose  Remove  Reduce Split  Group | I
Apply~ Jource ™ Sources~ Data settings Parameters ™  Preview ¥ HETEEE Columns = Columns ™ Rows ™ Column~ By 22 REplER b
ose New Query Data Sources  Parameters Query Manage Columns Sort Transform
Queries [1] < ft = Table.AddColumn(#"Changed Type"”, "First Name", each Text.BeforeDelimiter( v
I:| Sheet3 . | ABc Customer Name ~ || AB- Company Size ~ || ABc Customer Group - 123 Payment Terms ~ | ABc
1 John Doe Small Bronze
2 Jane Smith Medium Silver
3 Emily Johnson Large Gold
4 | Michael Brown Small Bronze
5 | Sarah Davis Medium Silver
6 | David Wilson Large Gold
7 | Jane Doe Medium Silver
8  Michael Davis Small Bronze

‘8 COMMUNITY
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Data Transformation Demo
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Visualizations
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Visualizations 52 COMMUNITY

e OhEH® b P 4Ed B 2 a D

Get Excel — Onelake SQL Enter Dataverse Recent Transform Refresh New Text More New  Quick Publish = Copilot
datav workbook data hub~ Server data sources v data~ visual box visualsv measure measure

Clipboard Data Queries Insert Calculations oty alale Copilot ~
<« Visualizations » l)ata »
=8 Build visual
- = Q_ Search
s P
5| - 4
= v [ Sheet3

Company Size

= bl E i = A
P A MR B
&l F O

Credit Rating
Build visuals with your data Customer Group

Select or drag fields from the Data pane onto the report canvas. Customer Name

Hﬂ @ w A R First Name
;'“"""""""i EE: E‘? @ @ R Parent Company
i------___-_r___im An: Py E =8 [ a CQJ [] >~ Payment Terms
: @ @ ?5_? E @ D IEI 2 Revenue
s [[] SalesRep
] State
Values

Add data fields here

There are many Out of the Box
Visualizations in Power Bl Desktop
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Visualizations (Bar Charts)

S

I_Fum of Revenue by Cusfomer Name

bin Emniy

Customer Name

=]

»

2 on H
Sum of Revenue

F

Y B2

avid lal 3

f' s...

ﬁ

._I

Sum of Revenue by Customer Name

L]
o
=]
[%]
=1 -
o I
0 Sk 10

Sum of Revenue

Y’ Filters o » Visualizations

L Search

Filters on this visual

Customer Name

is (All)

Sum of Revenue
is (All)

Add data fields here

Filters on this page

Add data fields here

Filters on all pages

AAdA Aata fialdc hara

‘8 COMMUNITY
2} SUMMIT

» Data

Build visual
Q_ Search

m @ @ % %SheetB
=1 [T (=l -

K TR @ LE:H: er IEI Credit Rating
[ Customer Grot

@ |[EI]' ﬁ E @ @ Customer Narr/

Hﬂ @ % A on () First Name

E @ @ R ] Parent Compa

Py E D-E I_V__I oa EQJ [] 2_ Payment Term:s

Company Size

— = 2_ Revenue
RREN R TR D7 -
[J Sales Rep
Il State
X-axis
Customer Name X
Y-axis
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Visualizations (Customizing Bar Charts)

Customer Name

A

YE_I...

Revenue by Customer Name Revenue by Customer Name

7.0¢
S0 50K sznz s [ <
= |
Michsel Davis 30K
oK

arsh Jane Mich... Mich.. D ne - -

auis Smith Brown Davis Wils. Doe s 5K 10
L Customer Name o Sum of Revenue
L — =

Y Filters @ > \Visualizations >
Format visjret=——

P | R

‘ L Search ‘

O Search

I
&
I
th

Filters on this visual

Customer Name
is (All)

Visual General

Sum of Revenue

is (All) > X-axis
Add data fields here > Y-axis
Legend

Filters on this page

Small multiples
Add data fields here

> Gridlines

Filters on all pages
> Zoom slider

Add data fields here
> Columns
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Visualizations (Tree Map)

« A wonderful way to display hierarchical data
« Data is displayed as set of nested rectangles.

S Filters % » Visualizations » Data >

e }3 Build visual Qs |
EA -e- Search — earc
[ICount of Company Size by First | m @ @
Name ' Qsheet’:
Emiy Filters on this visual :
E I_H_H_ E I]][ﬂ E [I]_ﬂ Company Size
| | Count of Company Size [} Credit Rating
_ is (All) & @ @ B LH!E. th M
. [ Customer Group
= First Name Iﬁ hﬂﬂ ﬁ |'L—J @ @ ] Customer Name
=-J is (All) @ EB A oA First Name

Bar Charts Page 1 II

Add data fields here

— 7= 9= 2 Revenue
_ _ b aiBig &2
Filters on this page - Sales Rep
State

Add data fields here

Filters on all pages

Add data fields here

E=EEER
PYE =B[1{) @

Category

First Name WX

Details

Add data fields here

Parent Company

2_ Payment Terms
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Visualizations (Line Charts) 22 SOMMpNITY

Y Filters o » Visualizations »

Y B -
ISum of Revenue by Customer Narfe . | Sum of Revenue and %GT Min of Revenue by Customer Name S h Format visual
o ®@5um of Revenue @%GT Min of Revenue /O earc _,_ ..... . r'_
10K 5009 :EEE: /
g B "
g E “00% Filters on this visual
@ a =
& &K 2 I3
IE I % 5 00% 'S ‘ /O Search ‘
E 2 £ Customer Name
oAk S oo = )
@ 00 g is (All) .
Visual General
2K 100%
Jokhin Emnily Sarzh lame Michagl  Michae David  Jane Dos John Emily  Sarah Jane  Michzel Michael Dawvid Jane
Coe Johnson Davis Smith Brown Davis Wilson Doe Johms.. Davis Smith Brown Davis Wilson Dos Sum Of Re\.l"en ue
L Customer Name . Customer Name is {A| |)
o > X-axis
Add data fields here > Y-axis

> Secondary y-axis
Filters on this page

> Legend

Add data fields here

> Small multiples

Filters on all pages
> Gridlines

Add data fields here

> Zoom slider

- D Bar Charts Tree Map Line Charts n
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Visualizations (Custom Charts)

Y Filters D D

£ Search

Filters on this page

Add data fields here

Filters on all pages

Add data fields here

Visualizations » Data »
Build visual Qs X
- earc
]
- D? ~ [ Sheet3
L] Company Size

E lEH E [hd] E mﬂ ] Credit Rating
p* A MR B |dk .

. o ustomer Group
@ |[EI]- E |'L—J ® @ ] Customer Name
Hﬂ @ % A oR ] First Name
E‘? @ @ R ] Parent Company
Py E n-E IV__l oa EQJ [] > Payment Terms
@ @ gli? EI_?J: @ D IEI 2 Revenue
4 L] Sales Rep

Get more visuals I ] state
valy Import a visual from a file
Adt
Remove a visual

Dril

Cro. Restore default visuals

3 COMMUNITY
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Many additional
custom
visualizations
available

Many additional #

Appsource f
visualizations are ~

available
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Visualizations (Custom Charts)

Power Bl visuals

(i) By clicking 'Add" and/or 'Download Sample’ and downloading a visual, you agree to the provider's Terms and Conditions and Privacy Policy on the visual's page and agree Microsoft can share your
account details to provider for their transactional purposes. Use of Microsoft's AppSource is subject to the Microsoft Commercial Marketplace Terms and Privacy Statement.

Allvisuals  Organizational visuals

AppSource visuals

Enhance your Power Bl experience using tested and approved visuals Learn more

Filter by | All

Zebra Bl Tables 7.0 %
Zebra Bl
o ke (12)

o
=

e

»
Performance Flow -... % Sunburst by Power... #%#
Wiz LLC TRUVIZ INC
FokAkd(16) ok ok (s)

p .~ S

L search

lcon Map Pro
Tekantis
ok dodkok (1)

Sort by: Popularity

¥ o
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Visualizations Demo
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Themes




Themes

File

Home

Insert Modeling

View

Optimize

Help

Aa
T

Aa
hilnll

Aa
lalualnll

-
Aa Aa IE?
Infualal] (Iskualnl Pag

view:

This report

Aa
Inluslnl

Accessible th

emes

Aa
laluslnl

Aa
laluslnl

Aa
Islualal

Aa
T

Aa
lilualal

Power Bl

Aa
il

Aa
[ ] |

Aa
lnlnsl

Aa
|I| alnl

Aa
il

Aa
lalial

Aa
hil:nl

Aa
lalualal

Aa
|I|I|

Aa
Liluln

Aa
lalualsll

Aa
|I | |

Aa

Page1 _. .

Aa

Aa

Aa
1Ll

{2 COMMUNITY
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Power Bl allows users to
customize their report
with custom themes
which include graph and
title colors and fonts

You can also import
themes
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Themes A oMMy

Power Bl forums > Galleries

Th Gall
emes Gallery Access the

Recently Posted Featured Top Kudos All Themes ~ Options = M i C ro S Oft T h e m e
poere " | o =l : 5 = & Library and

PowerBi o PowerBi

e I T T download custom

A

2N L - == —
Metrix Light Stellar Light Digital Marketing Dashboard | Marketing World Stats
Dashboard Template
Power_Viz 50 Power_Viz 51 Makkup 50 Shehab 50
o, . o— [ Y —— T ]
= [E— — —— i — — B— I— . P
T, . - = i 13m amw . e B = Em e
- . - ——rr : : :
B T L o ) - S
[ -, NS p—= - e P "
- m O = O |
- .
B . . ’ - -
Table Visual Financial Analytics Report Insights Online Learning | Analytics Report Bank Customer Churn
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Bookmarks A% SUMMIT

e Bookmarks are

File Home Insert Modeling View Optimize Help
_ } o |
Aa Aa Aa Aa Aa Aa IIE‘ I:I gsfld“:es i ? D I:E [% Klé% g reat tOO S to
v ) nap to gri . .
IIIIII I IIIIIIII IIII.III IIIIIIII IIII.III IIIIIIII V:’:\Ei Tg;sﬂf |:| Lock objects Flers BookmaricSelecton Pe:no r;zaef;‘:e sﬁigfs a d d to yo u r
R : Themes Scale to fit Mobile Page options Show panes
inl - > Y Filters <  »| Bookmarks > |Visualizations » Data re p O rt
@ /O . . D Add DoView Build visual Qs
earc & — ea

- =_ Bookmark 1 # [} ~ B sh ot BOOkmarkS allOW
ﬂg . e sox I Filters on this page ] O h
. | =5 EMEMEDR users to save the
pax) p— b - : .

ST i current state of a

Filters on all pages Hﬂ @ eﬂ A . El
Add data fields here E‘? @ @ R d report page

PYE =B 18 ©
b BAER2

including filters

Values

Add data fields here

Drill through

Cross-report (@oif)
Learn how to create and edit

L1 D Bar Charts Tree Map Line Charts Page 1 bookmarks Keep all filters m
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Mobile Layout

File View Optimize Help

J * Mobile layout is a

R e T =
wonderful tool

" « Mobile layout is also

. great for Sales teams,
Ef and it allows insights
on the go

OK7
50I( 5.0K

3.0K 5 ok 2.0k
- - .

) ’é a \
\O\'\*\ g{\ cja‘«"" \\1\\5\ \\E\\& Qa‘ S?)0"*

Revenue by Customer Name

John Doe
Emily John... | A s o«
sarah Davis || NN 7.0«
i Janesmith | 5o I
Michael Br_. | N 5o

Mickhant I - A
(- D Bar Charts Tree Map Line Charts Page 1
I

Pane 1 nf4 =5
~ @ 2024 Dynamic Communities



{3 COMMUNITY

Themes, Bookmarks, and
Mobile Layout Demo
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Interactive Dashboards
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Interactive Dashboards: Drill Down  :*SOMMUNITY

Y Filters D D

« e« Power Bl allows
£ search 2 users to create
= Flj:l::;:mi:h E% Filters on this visual 3 h ie ra rC h ieS
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Collaborating and Sharing
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Thank you for attending!
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